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Next Meeting:
November 5

Mike Kaltschnee
on Danbury Hackerspace
and the hot new maker movement

Directors’ Notes

A

meeting of your board of directors
was held on Wednesday, October 9,
2013. The meeting was called to order at
7:05 PM.
Attending were Richard Corzo, Jim
Scheef, Richard Teasdale, Lisa Leifels,
Annette van Ommeren, Drew Kwashnack,
Andy Woodruff, Bruce Preston, Bill
Saturno, Dave Green. Guest: Charlie
Bovaird.
The minutes of last meeting were
accepted.
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Old Business
1. General meetings
• October 1: Bruce Preston - Virtual
Machine Technology, how it works and
demonstration. Preview: Jim Scheef,
Review: Jim Ritterbusch.
• November 5: Mike KaltschneeDanbury Hackerspace. Preview: Bill
Saturno, Review: Sean Henderson
(Andy Woodruff backup)
• December 3: Bill DeRosa-Facebook
and Pinterest. Preview: Lisa Leifels,
Review: Richard Teasdale
• February 4, 2014: Jay Ferron-Windows 8.1. Preview: TBD, Review: TBD
• Possible future topics:
o Shall we do a "Meet the SIG"
segment between the Ask DACS session and the featured presentation?
What SIG should do September? Some
suggestions: Mobile Devices, Linux
(Raspberry Pi perhaps?), Drupal, Web
Design.
o "LifeStream" monitoring. Mike
Kaltschnee mentioned FitBit (currently available at BestBuy) or other
'wearable electronics'. Considering
session on wearable technology such
as this for the January session. Andy
spoke with Jeff Schlicht, professor of
phys ed at West Conn, about a possible presentation at DACS re wearable electronic devices that monitor
exercise and/or body functions. Bill
may have access to someone who has
Google Glass, and perhaps other
health-related wearables.
o Bruce did a Virtual Machine session in October and showed that an XP
machine (or earlier) could be built to
support legacy applications. Should we
also schedule a hands-on workshop as
a follow-on? Did we ask audience members at the meeting? We will see if Sean
would like Bruce to assist in setting up
a workshop. Decision must be made
within a week so as to make announcement in the November newsletter.

ASK DACS

10

o Now that the new OS X Mavericks release has been announced to

FUTURE EVENTS

12
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dacs.doc, ISSN 1084-6573, is published
monthly by the Danbury Area Computer
Society, 27 Ole Musket Lane, Danbury, CT
06810-8232. Annual subscription rates: $45 to
regular members, $30 electronic access (included in dues).

Postmaster
Send address changes to Danbury Area
Computer Society, Inc., 4 Gregory Street,
Danbury, CT 06810-4430.

Editorial Committee
Managing Editors:
Production Editor:

Richard Teasdale
Ahmad Asgharian
Allan Ostergren

Contrib
utor
s
Contributor
utors
Charles Bovaird
Drew Kwashnak
Rob Limbaugh
Jim Scheef

Richard Corzo
John Lansdale
Bruce Preston
Annette van Ommeren

DACS, its officers and directors assume
no liability for damages arising out of the
publication or non-publication of any
article, advertisement, or other item in this
newsletter.
The editors welcome submissions from
DACS members. Contact Richard Teasdale
(dacseditor@dacs.org). Advertisers, contact
Charles Bovaird at (203) 792-7881
(aam@mags.net)
Nonprofit groups may request permission to
reprint articles from dacs.doc or http://
www.dacs.org by sending e-mail to
reprints@dacs.org. Reprinted articles shall
credit the copyright holder and a copy of the
final publication shall be mailed to:
Danbury Area Computer Society, Inc.
27 Ole Musket Lane
Danbury, CT 06810-8232
Attn. Reprints
Links to articles reprinted on the web can be
sent to: reprints@dacs.org

Tec
hnical Suppor
echnical
Supportt
dacs.doc is prepared using PageMaker
7.0 and Acrobat 9.0.Software packages
used to publish dacs.doc include:
Microsoft Windows 7, Office 2007,
TrueType fonts, Calendar Creator 8.0
for Windows. Internet access provided
by AT&T

Applications & Hardware to
enhance dacs.doc are welcome.

Bill Saturno
APCUG Liaison
wsaturno@dacs.org
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HelpLine
Our former telephone HelpLine has been replaced by our web-based DACS
Community Forum at http://forum.dacs.org. We have topic-specific forums where
DACS members can post questions. Questions may be answered by SIG leaders
or other DACS members. If none of the categories fit your question, just post it to
the Ask DACS forum.

Topic

Forum

Microsoft Access
.NET Programming
Digital cameras/scanners/image processing
Content Management Systems
Linux
Mac and iPhone/iPad/iPod touch
PC maintenance
Smartphones & Tablets
Virtual machine software
Desktop publishing and website design

Access SIG
ASP.Net and C#VB.Net SIG
Digital Imaging SIG
Drupal SIG
Linux SIG
Apple SIG
PC Maintenance SIG
Mobile Devices SIG
Virtual Computing SIG
Web Site Design SIG

Windows

Windows SIG

http://www.dacs.org

come out in the fall, we should ask
Dave Marra to do another presentation as the time draws nearer. It need
not be immediately after release, so
something like January or March
would be good.
o Andy suggested a session on
creating a web site of various types:
blog, brochure, e-commerce site, etc.)
- making use of such as products/services as site builder (online or on PC),
turn-key sites, etc. Andy suggested
that as a computer group we should
do some sort of session that would
answer the question: "I think I need
a web site, what are my options?"
This might involve a "high level"
overview of the various approaches.
Andy (and to some extent Bruce)
wanted to talk about the entry level
'turn key' systems where you must live
within the constraints of the design,
where Annette is more concerned
about "What happens if it doesn't
do what you want it to do?" Annette
and Andy will discuss creating an
outline that describes at a high-level
what components might be a part of
a web site and the repercussions they
have upon the construction of the
site.
o Lisa suggested a "decision tree"
presentation - "What should I get?" Windows or Mac, Desktop, All-inOne, Notebook, Tablet, or even
SmartPhone - Android or iOS, etc.
Lots of decisions - how to decide
what meets your needs. We think this
would be a 'tough' presentation to pull
off but a lively session. Bruce, Richard C, Jim and Charlie will work on
defining the metrics.
2. Bill Saturno is our new APCUG representative. He is receiving APCUG emails but not everything. It appears
that APCUG has multiple distribution
lists based upon functionality. For example Richard C is deluged with APCUG
mailings perhaps 4 per week, while Bill
has only received 8 since July..
3. Opening positions
• Treasurer when Dave Green retires March 31. Richard C's two possibilities came up dry. Does the treasurer need to be a CT resident, since
we use the treasurer's home address
as the club's legal address: Answer:
No. Richard T. has identified a canDirectors’ Notes, Cont. on page 4
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Meeting Review
Go Back in Time with Virtual Machines
By Jim Ritterbusch

A

RE YOU STILL doing fine without
InDesign, or are you an old hand
with a DOS command? Keeping up
with the computer revolution can be a
daunting task for even the most tech savvy
computer user.
On October 1st, Bruce Preston presented
“Virtual Machines for Backward Compatibility (and a lot more)“. He suggested
a number of reasons why one might want
virtualization, such as support for legacy
applications, obsolete hardware, regression
testing, and more.
Using the analogy of
a Windows calculator being a “virtual
calculator” that fulfills all of the functions of a real calculator, Bruce explained
the principal of
virtualization being
implemented completely in software.
Detailing the normal PC boot process,
Bruce explained how
virtualization is different from dual-booting. He elaborated on
many facets of the boot process. He
walked us through the virtualization from
mainframes through mini-computers and ultimately on desktop PCs. He provided us
details on the software/hardware interface,
the hardware abstraction layer, device drivers, and tied it all together into a conceptual diagram of a physical computer.
Bruce then introduced the hypervisor,
the housekeeper that keeps all of the virtual components in their proper places. He
showed us various different hypervisors.
For the purpose of this demonstration, he
focused on the VirtualBox hypervisor,
freeware published by Oracle. He tied the
virtual PC back to the conceptual diagram
presented earlier.
He then listed the steps to create a virtual machine using VirtualBox, whether the
VM was Windows 8, Vista, Windows 95, or
even DOS. Bruce elaborated on options
for internet connections to the outside
world, as well as a Disk2VHD utility that
can take an existing single-boot Windows
installation and convert it to a VM, with
that version of Windows running as the
guest underneath.
Bruce provided some resource links,
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such as http://www.virtualbox.org and
http://www.vetusware.com. He explained
that there are some compatibility issues with
old software applications, especially those
that used code which directly accessed
hardware. A primary example was the original Microsoft Flight Simulator, which was
tied to early PCs’ 4.7 MHz clocks. Running
on a modern machine at 3.4 GHz would
cause your Cessna 150 to fly 700 times faster
and crash immediately on takeoff!
Following the pitch, Bruce presented a
live demonstration
of installing a virtual machine on his
existing computer
r u n n i n g
VirtualBox. For the
VM, he selected
Microsoft DOS
6.2, due to the
quick installation
time. This was accomplished in a
few minutes. A
question and answer period ensued.
All-in-all, an informative and interesting presentation. Thanks, Bruce!
Bruce’s presentation is available in PDF
format on the DACS download page, at
http://dacs.org/pdf/VM_Present_v1_
DACS.pdf .

didate who seems enthusiastic. He
will follow up and ask him to talk to
Richard C. Dave has prepared a document detailing the functionality required.
• President when Richard Corzo retires March 31.
• Replacements for retiring "oddyear class" board members Drew
Kwashnak and Annette van Ommeren
in December. Jim, Lisa, and Bruce are
continuing. Dave Green is also retiring
in December as an "even-year class"
board member after serving just one
year of his term.
New Business
1. Sean Henderson will be doing his
annual music production workshop on
November 22.
2. Jim has been looking into the feasibility of implementing a 'split domain' where e-mails may be serviced
by either Microsoft 365 or our current mail server on Bluehost. The
reason that he wants to do this is that
if a member with an @dacs.org address could make use of the MS Exchange functionalities available, such
as centralized Outlook calendar that
can be synchronized across devices.
He is in the process of determining
as to whether this can be done without impacting existing accounts.
Adjourned: 8:50PM
—Bruce Preston

Do the General Meetings leave you thirsting for more?
Find all that after the meeting at the DACS Pig SIG.
http://www.dacs.org

Meeting Preview
Mikey Maker’s Back in Town
by Bill Saturno

I

F YOU HAVE EVER ASSEMBLED a
Heathkit project, gathered with others
at a local SIG to discuss programming,
or tinkered with tubes at a meeting of a
Ham Radio club, you will be glad to know
that the innovative,
creative tech culture is
alive and well today.
A renaissance has
bloomed recently, as
shown by the resurgence of the “Do It
Yourself” movement.
This movement is no
longer a niche - Time
and Forbes magazines
acknowledge
the
growing maker movement as well as the
places where these
creative souls congregate. The DIY movement is often referred to as “making” or
“hacking”, and their clubs and workshops are known as “makerspaces” and
“hackerspaces”.
The November general meeting welcomes speaker and DACS member Mike
Kaltschnee, co-founder of the Danbury
Hackerspace at The Innovation Center.
This facility, opening in Danbury later
this year, will be one of the newest
hackerspaces in Connecticut. The
Danbury Hackerspace will be linked with
the Danbury Innovation Center, which
encourages new local business development and provides resources for
growth to businesses in the local community. Mike will discuss the involvement of the City of Danbury in the
project, which included a $550,000 commitment to renovate the facility space.
The Danbury Hackerspace will be
open soon and Mike will explain the
types of activities and events the space
will run for makers, entrepreneurs, artists, hackers, and craftspeople. In addition to discussing the Danbury
Hackerspace, Mike will describe
makerspaces in general, coworking
spaces, as well as the recent growth and
influence of crowdfunding (Kickstarter,
Indiegogo, etc.). Mike will also cover CT
Next, Maker Faires, as well as providing
information
about
established
hackerspaces in our area, such as CT
Hackerspace, NESIT, and Make Haven.
http://www.dacs.org

Xerox PARC and Bell Labs may
have closed their doors but new opportunities at hackerspaces are the places
where people are going to create and
build “the new stuff” for tomorrow - lifechanging products
and technologies,
and writing code
that will change the
world.
DACS meetings
are held at Danbury
Hospital auditorium.
(Go to www. dacs.
org to find directions and parking
info). Doors open at
6:30 p.m. for registration and casual networking. Meetings
start at 7:00 p.m. with
a Q&A period (Ask
DACS), followed by announcements
and a short break. The featured presentation begins at 8:00 p.m. The meeting
is scheduled to adjourn at 9:30 p.m.
DACS General Meetings are free and
open to the public. Members and prior
attendees are encouraged to extend
invitations to anyone interested in
this topic.

DACS Community
Forum
Ever wanted to ask a question
and get an answer without waiting
for the next general meeting? How
about sharing news with other
DACS members, or communicating with fellow participants in a SIG
you attend?
The DACS Community Forum
(http://www.dacs.org/forum/) is
another benefit of being a DACS
member, and it’s open 24/7. Once
you register there you'll be able to
post questions, answers, and comments. You can even set up an RSS
subscription to be notified of
updates to the forums.
Try out the DACS forum
today!
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Special Interest Groups
SIG NO
TES: No
vember 2013
NOTES:
Nov
Apple. Focuses on all aspects of the Mac and iPhone
operating systems.
Contact: Richard Corzo (macsig@dacs.org).
Meets 2nd Monday, 7 p.m. at DACS Resource Center.
Next Meeting: Nov 4
Digital Imaging. All about digital cameras, retouching, and
printing using various programs.
Contact: Ken Graff at 203 648-9747 (thedigitalwiz@gmail.com).
Meets last Wednesday, 7 p.m.at the DACS Resource Center.
Next Meeting: Nov 27
Drupal. Covers all things on Drupal, the open source content management system (CMS).
Contact: Jim Scheef (jscheef@dacs.org).
Meets on the second Thursday at 7:00 p.m. at the DACS
Resource Center, or go to the DACS Community Forum (http:/
/www.dacs.org/forum/) within the Members only area.
Next meeting: Nov 7
Jobs. Networking and jobs search
Contact: Charles Bovaird, 203-792-7881 (aam@ mags.net).
Go to DACS Community Forum (http://forum.dacs.org for
job listings.
Linux. Helps in installing and maintaining the Linux operating
system. Also of interest to Apple owners using OS X.

Contact: Dave Mawdsley, linuxsig@dacs.org
Meets 3rd Wednesday, 7:30 p.m. at the DACS Resource Center.
Next Meeting: Nov 13
Mobile Devices. Focuses on smartphones, tablets, and ereaders of all makes and models.
Contact: Richard Corzo and Jim Scheef (Mobilesig@dacs.org)
Meets 4th Monday, 7 p.m. at the DACS Resource Center
Next Meeting: Nov 18
PC Maintenance. Review of PC hardware and OpSys
maintenance and use.
Contact: Charles Bovaird, 203-792-7881 (aam@ mags.net).
Go to DACS Community Forum (http://forum.dacs.org).
Server. Explores Back Office server and client applications, including Win NT Servers and MS Outlook. SIG is
on hiatus and presently merged into the Drupal SIG.
Contact: Jim Scheef (jscheef@telemarrksys.com), or go
to the DACS Community Forum: http://www.dacs.org/forum/, within the Members-only area
Web Design and DTP. Learn about Adobe software for
web, graphics and desktop publishing.
Contact: Annette van Ommeren (avo@annagraphics.com).
Meets 3rd Tuesday, 7-9 p.m. at the DACS Resource Center.

Next Meeting: Dec 17

SIG News & Events
Apple. At the October meeting we talked about the new iOS 7
software available for the iPhone and iPad. This is a major
overhaul to the look of the interface, with several new features.
Gone are the skeuomorphic elements that looked like real
materials such as felt, leather, or wood. Icons have a flatter,
more colorful look, but now some items are placed in layers
with translucency added to give a sense of the layer underneath. The notification center includes a Today view that gathers information for a quick glance at today’s weather, schedule,
stock prices, etc. A swipe up from the bottom reveals the new
control center for quick access to certain settings like Wi-Fi,
Airplane mode, music player controls, a calculator, and flashlight. It’s almost like getting a new phone just by updating the
software. For those noticing a decrease in battery life, check
the new Background App Refresh setting under General and
turn off any apps that you don’t need to have refreshed in the
background. Some less obvious features are those that make
it difficult for thieves to wipe an iPhone and resell it.
Later in the meeting one Mac user reported having had
some trouble making video calls with a relative. Using me as
the other party, we were able to successfully conduct both
FaceTime and iChat video calls with his and my MacBook Pros.
Linux.
Tonight’s meeting included two presentations: 1. “Using Scientific Formulas Inside a LibreOffice Writer Document,” a how-
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to demonstration using the methods with scientific equations in
a Writer document; and 2. “Installing nVidia Support,” an example of using proprietary code along with an otherwise opensource Fedora environment to solve a serious video problem.
1. “Using Scientific Formulas Inside a LibreOffice Writer
Document” (changing plain text formulas to fancy formats)
With any text writer or editor, expressions such as C^2 =
A^2 + B^2 are useful and are fairly clear, but they’re not very
elegant in a nice presentation. As a quick fix, the expression
could be written C2 = A2 + B2 and then just reformat the
characters with superscript to make the equation look better
such as C2 = A2 + B2 .
Using Microsoft Word 2007, there are some options that
might be enough for simple expressions. Use the ‘Insert’
ribbon of Word to find some simple pre-made formulas along
with an extensive list of math and science symbols at the far
right of the ribbon.
A more elegant solution is to use LibreOffice Writer, which
is available free for Windows, Apple and Linux. Writer contains
an on-board equations editor that can deal with expressions
such as C^2 = A^2 + B^2 with ease. Once written that way in a
Writer document, simply select the expression, use Insert >
Object > Formula, and the conversion to the desired form is
immediate. Later formatting for font size and bold can be done
as well.

SIG Notes Cont.on page 9
http://www.dacs.org

November 2013
Danbury Area Computer Society

Apple
7:00 PM
Richard Corzo
macsig@dacs.org

General Meeting
7:00 PM

Board of
Directors
7:00 PM

Linux
7:30 -9:30 PM
Dave Mawdsley
linuxsig@dacs.org

Mobile Devices
7:00 PM
Jim Scheef &
Richard Corzo
mobilesig@dacs.org

http://www.dacs.org

Drupal
7:00 PM
Jim Scheef
860-355-0034

SQL Server
Study Group
7:00 -8:30 PM
Sean Henderson
203-837-7068

DACS.DOC
Deadline

Digital Music
Workshop
7:00 PM
Sean Henderson
sean@museworks
entertainment.com

Digital Imaging
7:00 PM
Ken Graff
203 648-9747
thedigitalwiz@gmail.com
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Memories
Shirley, Goodness and Mercy
by Allan Ostergren

Editor’s note: Shirley Fredlund passed
away on September 30, after a brief
illness.

W

HEN I FIRST MET Shirley
Fredlund in June 1991, DACS
was an up-and-coming organization of about 100 members, and had just
moved into larger meeting accommodations
at Brookfield’s DATAHR rehabilitation center. The computer revolution was spawning legions of followers, anxious to master
the new technology and to explore its possibilities.
Shirley was recruiting volunteers for
Voice for Joanie, an organization she had
created in honor of her friend Joan
Margaitis, a victim of amyotrophic lateral
sclerosis (ALS). More commonly known
as Lou Gehrig’s disease, ALS attacks motor neurons in the body, causing muscles
to weaken and atrophy and resulting in paralysis and death. Shirley and a close friend,
Frank Ruiz, had obtained a grant from IBM
for a communication system, but it arrived
just too late to help Joanie.
DACS eagerly embraced Shirley and her
cause, forming a Voice for Joanie SIG to
recruit volunteers and an assistive technology SIG to develop new devices to help
ALS victims communicate. Although this
was part of a general community outreach
initiative to fulfill DACS’ nonprofit status,
that also included refurbishing used hardware, training seniors and other community projects, it was eagerly pursued, and
earned considerable recognition for DACS.

Assistive technology is a broad and
fiercely competitive field developing rehabilitative devices for the physically impaired.
For ALS victims, it typically consisted of a
word processor that could receive commands
from a pointing device tailored to the user’s
physical abilities. The muscles of the eye are
normally the last to be affected by paralysis,
so an infrared switch was developed to enable patients to blink to select text on the
computer screen. The system, used by astrophysicist Stephen Hawking is the most
common example, although many similar tech-

In foreground: Frank Ruiz, Shirley Fredlund and DACS
president, Dick Gingras at REACH Award ceremony
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nologies—even thought-based switches—
are being developed.
Although ambitious and well-intentioned, the assistive technology SIG never
achieved its goal of cheap, off-the-shelf devices for the handicapped. But the magic of
Shirley’s personality and determination,
combined with DACS’ growing community
outreach initiative and computer industry
connections proved a powerful combination.
In April 1993, DACS participated in a
nationally televised promotional launch of
MS-DOS 6 at Danbury Hospital. More than
$7,200 was donated by 300 members and
guests at the event, and Microsoft agreed
to match the total for a grand total of $14,462.
In 1994, DACS and Voice for Joanie won the
national REACH Award (Recognizing ExcepRemembering Shirley, Cont.on page 11

Microsoft’s Bob Jones and Sue Page present big check
to Shirley Fredlund, Tom McIntyre and Dick Gingras
http://www.dacs.org

SIG Notes, Cont. from page 6
As an alternative, when it’s time to insert an equation, use Insert
> Object > Formula and the equation editor opens and allows for
typing in the bottom pane. Then clicking back in the upper pane
changes the typed equation to the form desired.
When the equation editor is open, right-mousing next to
the equation typed brings up a list of useful tools such as
formatting and special functions. The View menu also gives
the option ‘Elements’ which reveals standard forms for fractions, integrals, relations and so on—those found in science
and mathematics. Chemical formulas, matrices, physics constants, and so on are also possible.
Excellent resources are available to get started in the
LibreOffice equation editor:
A. “LibreOffice 3.5 Math Guide Using the Equation Editor” at
https://wiki.documentfoundation.org/images/6/65/
MG35MathGuide_LO.pdf
B. Full Circle Magazine has a comprehensive write-up in
“LibreOffice Special Edition Volume Three” the workings
of the formula editor. The direct link is: http://
dl.fullcirclemagazine.org/issueLO03_en.pdf The article
featuring the equation/formula editor begins toward the
middle of the issue and it is very comprehensive.
2. “Installing nVidia Support” (coping with graphic card needs
and using proprietary binaries instead of open source ones)
With Linux distributions. generally a new install searches
out the hardware as it installs and it automatically assigns the
best drivers for that hardware—which it already contains. Thus
when restarting after the install, the final restart process is
seamless. It isn’t fool-proof however. Some hardware can
still be outside the accepted list. When that happens things
don’t work correctly.
Jim Ritterbusch presented a sticky-wicket issue involving a
downloaded binary nVidia card driver to run the video card on his
computer. It seemed that the Linux distribution, Fedora, lacked a
required proprietary binary for nVidia. Jim found that his computer couldn’t properly use the existing video card with drivers
supplied by Fedora’s repositories. So being creative and brave,
he went hunting for a driver that he could successfully use.
Luck would have it that a working binary was available
thus making it unnecessary to manually compile code from a
source listing. However, the binary required that the repository
containing it would also have to be utilized. In a sense, that
repository is considered uncertified and is generally disallowed
by the Fedora community because Fedora prides itself on using only open source code.
After a struggle to install and configure the driver, Jim
found that all went well until an update from the regular
Fedora repositories installed a new Linux kernel. The new
kernel, once installed, required a reinstall of the same
nVidia binary each time it was updated. I doubt that the
average user would be up to this repetitive task—especially when kernel updates appear every week or so. But
Jim’s work-around solved the issue.
Next Linux SIG Meeting
At the November 20th meeting, the topic “Using the GIMP
Cloning Tool with Photos” will be presented. This topic is meant
for the beginner using GIMP. Attendees to our meetings are
always welcome to raise topics and issues as they feel the
need to do so. This is the Linux community’s normal way of
sharing ideas, methods and code. Our Linux SIG continues
always in that spirit.

http://www.dacs.org

Join us at our next meeting in the DACS Resource Center
of Ives Manor. Bring your laptop, Arduino or Raspberry Pi and
show us a thing or two. Our meetings are for the beginner,
intermediate or advanced user, so topics vary considerably
depending upon the needs of the attendees. Linux topics cover
software and hardware along with the joys and sorrows of those
using it.

Mobile Devices. In September we talked about transferring
music to a mobile device. Typically you can connect your phone
or tablet to your computer using a USB cable and have it show
up as a removable drive. Unlike photos, where the built-in
camera’s photos always seem to be located in a folder called
DCIM on the device, music files may go into different locations
on different devices in order to be recognized by the music
apps on the device. On my NOOK HD+ I have the folder My Files
> Music, where the various apps can find my locally stored music. Within that folder the music is normally organized first by
folders for each artist, and then by subfolders for each album.
On many Android devices the Google Play Music app is
built in and will recognize and play locally stored music files.
Your device manufacturer may also have a music app. At the
meeting I showed the eMusic app as another one that can play
locally stored music. It’s also a music subscription service
from which you can download a designated number of songs
each month, or purchase songs a la carte. The more famous
option for accessing music in the cloud or downloading it locally is the Amazon MP3 Store and their Cloud Player. The Cloud
Player is available from any web browser, or on a wide variety of
devices as an app, and now even as a PC or Mac desktop
application. On devices, the app can download music that you
have bought from Amazon, or a limited amount of music that
you acquired elsewhere and previously uploaded to the Amazon cloud.
In contrast, Apple’s mobile devices are loaded with music by
using the iTunes application on a computer, or by purchasing
music directly in the iTunes store app on your iPhone, iPad, iPod
touch, and now the Apple TV box. You can also enable the iTunes
Match feature to allow access to music in the cloud that you
haven’t directly transferred from your computer.
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Ask DACS
October 2013
Moderated and reported by Jim Scheef

W

E WELCOME QUESTIONS FROM the floor at the start of our General
Meetings. The role of moderator is to try to guide the discussion to a likely
solution to the problem.In addition, members who are not able to attend the
General meeting may submit questions to askdacs@dacs.org. We will ask the
question for you and post the reply in dacs.doc and on dacs.org. Please provide as
much information as possible, since we can’t probe during the session.
Q – I purchased a Lenovo laptop a few
months ago from TigerDirect that
came with Win7 preinstalled and
Windows 8 on the recovery partition.
The machine came with 8GB of
RAM. I was told that if I upgraded
the RAM to 16GB then I would be
able to install Win8 to dual-boot. I
would like to know if this is accurate.
A – What you describe with Win8
recovery disk images on the machine
is probably correct. TigerDirect is a
reputable company that stands behind
what they sell (from personal
experience). If the machine came with
licenses for both versions of
Windows, there should be no problem.
Win7 and Win8 use the same boot
loader, so they work well in a dual-boot
setup. The extra RAM is not necessary
to install Win8, since a dual boot
configuration makes no extra demands
on RAM as only one operating system
can be running at a time.
The first step would be to create a
separate partition for Win8. In a dualboot configuration, the ideal setup is
three partitions: one for each of the
operating systems and the third for
your data. That makes it easy for both
OSs to use the same data directories
and allows you to reinstall either OS
without endangering your data. I have
this exact same configuration on my
main machine and it works quite well.
Q – I have an iPad 2 and installed the
iOS-7 upgrade. Has anyone else done
this? With the new OS, my batteries
don’t last. Apple suggested doing a
clean install but I don’t see how that
will solve the problem.
A – This question generated a lot of
discussion. Apple support suggested
doing a clean install of iOS-7, which
will put the device in a known state
where Apple can support it.
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Discussion moved to how had battery
life changed under the new OS. This is
really difficult to assess without doing
repeatable benchmark testing. Gut feel
is an unreliable measure as one naturally
wants to use the new features in the
new OS. Otherwise, why upgrade?
Suggestions like reducing screen
brightness are not really palatable as
they make the device less pleasant to
use. Carrying this to the extreme, a really
horrible device will have infinite battery
life because no one will ever use it.
Q – How can I turn off dynamic device
management (DDM) in Windows 7 so
my Win7 machine will not lose its
keyboard, mouse and printer?
A – No one knew what DDM is. The
problem is that when Win7 goes into
sleep mode and then reawakens, it polls
all the USB devices. Many older USB
devices do not support polling in this
state and thus fail and become
unrecognized. The member’s concern is
a KVM (keyboard, video, mouse) switch
and a USB parallel port adapter used
with an older HP LaserJet printer.. Older
laser printers (both HP and other makes)
often continue to work because they can
use HP PCL (printer control language)
and can be installed in Vista and Win7
by telling Windows that the printer is
an HP LaserJet V, which in this case may
be the truth. So a Win7 device driver is
not an issue even for a 15-year old
printer. In this case the problem is the
adapter needed to connect a printer
made before USB to a computer that
does not have a “legacy” parallel port.
Various people in the audience related
similar KVM experiences when moving
to Win7. Most bought new USB-based
KVM switches which solved the
problem, although one person
mentioned problems on bootup. In my

own “server farm” I use two entirely
manual Cybex PS/2 and VGA 4-port
switches. A physical button press
switches the physical keyboard, mouse
and video monitor between the four sets
of ports connected to various machines.
The switch makes all four machines
believe they are always connected to a
keyboard and mouse so the machines
boot properly and Windows does not hang
when the machine is being “ignored”.
KVM devices intended for home use now
include sound so your speakers are
always connected to the active machine.
When discussion returned to the
printer, one member suggested using a
network “print server”. These are
typically small devices with just enough
smarts to listen to the network and
direct print jobs from computers on the
network to the printer. Office-grade HP
LaserJets from this era had a dedicated
slot for an HP JetDirect device that
served this function. Used JetDirect
devices can be found on eBay for as
little as $6.75 with “free” shipping. Now
a network connection is standard in all
but the very cheapest home printers.
Q – I’m having trouble with one
computer where my documents want
to print on A4 paper rather than
standard letter size (8 ½ x 11). I’m
forced to change the printer each time
I print a document. How can I get the
default paper back to letter size and
make it stick?
A – We had a hard time understanding
this problem at first until the member
explained that the machine had been
configured for UK English to get the
character for British Pounds, etc. Now
that the Windows has been set back to
US English, documents still want to print
on A4 paper. A member in the audience
pointed out that Word caches printer
configuration information in each
document. Thus all documents created
while in “UK mode” must be opened and
changed in the page layout to letter size
paper and resaved. Doing this may
change the document formatting slightly
as the margins and width of the paper
change. If new documents are also
defaulting to A4 paper, the “default
template” is configured for A4 paper.
Microsoft Office stores templates
separate from your documents and the
exact location varies with the version of
http://www.dacs.org

Windows and the first version of Office
installed. Templates are further
distributed between folders for personal
templates and common templates. The
easiest way to find the default template
would be to search for default.dot or
default.dotx. If you do not have any
custom styles in this template, simply
delete default.dotx and Word will make a
new one the next time it runs.
Q – I have three machines running
different versions of Windows.
Application program files seem to be
in different folder names. I want to
install an old program on the new
machine, where should I install it?
A – The answer depends on the “bit-ness”
of your version of Windows. To
determine if you have 32-bit or 64-bit,
open the System Applet in Control
Remembering Shirley, Cont. from page 8
tional Achievement in Community Help)
sponsored by Ziff-Davis and the APCUG.
In 1998, DACS received a “Jerry Award”
for its Community Service Projects, from
the Association of PC User Groups. The
awards, named for APCUG founder Jerry
Schneider, recognize and support outstanding volunteer initiatives with $500 grants
sponsored by Oracle, Microsoft, and
Adobe Systems.VFJ has been declared an
official charity for corporate matching
funds on behalf of Microsoft employees,
and a special $1,300 contribution from
Microsoft in 1999 helped send a PC and
monitor to an ALS victim in southern California. Over the years, these companies
and many others have generously sup-

Panel. If it does not mention 32- or 64bit, then it is 32-bit. The default locations
are in the table below.
Note – There were two questions that I could
not make out on the recording. Sorry!
Thanks to John Kin for sending me
his recording of Ask DACS this month
as it was often intelligible where my recording was not. It is imperative that
everyone speak toward the podium; I can
always repeat things that people in the
back can’t hear. Repeating things

[Disclaimer: Ask DACS questions
come from members by email or from the
audience attending the general meeting.
Answers are suggestions offered by
meeting attendees and represent a consensus of those responding. DACS offers no warranty as to the correctness of
the answers and anyone following these
suggestions or answers does so at their
own risk. In other words, we could be
totally wrong!

ported Voice for Joanie with grants and
charitable contributions.
But while DACS was a catalyst in this
powerful formula, it was Shirley Fredlund’s
wisdom, personality and incessant determination that drove the process. Through
a tireless 14-year campaign of grant applications, fund-raisers, and events, and a determination that every penny goes to help
her clients, she had managed to provide a
gift of speech to close to a thousand needy
patients in our tristate region.
Voice for Joanie provides a unique service to its clients that goes beyond all others. Although Medicare covers assistive
devices, it limits this benefit to a single system, which may become useless as the
patient’s condition progresses. ALS sup-

port groups provide valuable human services and counseling, but may lack the
technical knowledge to evaluate patients’
special needs. Voice for Joanie is a type of
lend-lease service that analyzes a client’s
abilities and provides continuing assistance based on current needs. All systems
are returned to Voice for Joanie when no
longer needed and are then allocated to
other users.
Shirley’s work will be continued by
her long-time friend and husband of 15
years, Frank Ruiz, whose ties to IBM
helped provide the first grant for Joanie
from IBM. Volunteers wishing to help in
the maintenance and distribution are
welcome, and should call Frank at (203)
770-6203.

Shirley and Frank with Wayne and Rose Parent at Microsoft event in Hartford.
An ALS patient, Wayne served as good will ambassador for Voice for Joanie
http://www.dacs.org

ensures these details are on the
recording.

Shirley accepting the 2013 Myra
Kraft Community MVP Award from
the New England Patriots
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Voice
for
Joanie
Help give the
gift of speech
Call Frank Ruiz
at 203 770-6203
and become a
Voice for Joanie
volunteer
www.voiceforjoanie.org

When you come to the next DACS meeting,
why not bring a friend?
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